Accessibility: Optimizing Word and PowerPoint Files
Delivered by IT Learning and Development for Penn State

Version 08/04/2017
Alternative Format Statement
This publication is available in alternative media upon request. Penn State encourages qualified persons with disabilities to participate in its programs and activities. If you anticipate needing any type of accommodation or have questions about the physical access provided, please contact itld@psu.edu or 814-863-9522 in advance of your participation or visit.

Statement of Nondiscrimination
The University is committed to equal access to programs, facilities, admission, and employment for all persons. It is the policy of the University to maintain an environment free of harassment and free of discrimination against any person because of age, race, color, ancestry, national origin, religion, creed, service in the uniformed services (as defined in state and federal law), veteran status, sex, sexual orientation, marital or family status, pregnancy, pregnancy-related conditions, physical or mental disability, gender, perceived gender, gender identity, genetic information, or political ideas. Discriminatory conduct and harassment, as well as sexual misconduct and relationship violence, violates the dignity of individuals, impedes the realization of the University’s educational mission, and will not be tolerated. Direct all inquiries regarding the nondiscrimination policy to Dr. Kenneth Lehrman III, Vice Provost for Affirmative Action, Affirmative Action Office, The Pennsylvania State University, 328 Boucke Building, University Park, PA 16802-5901; Email: kfl2@psu.edu; Tel 814-863-0471.

Use of Confidential Materials
Due to the confidential nature of the materials contained within this document please be cautious in its use and availability to others. This data is intended for the sole use of the individual for which it was created. Thank You.

Copyright 2017 - The Pennsylvania State University
These materials are for personal use only and may not be copied or distributed. If you would like to use our materials for self-study or to teach others, please contact us at IT Learning and Development, 814-863-9522, or itld@psu.edu. All rights reserved.

The names of software products referred to in these materials are claimed as trademarks of their respective companies or trademark holders.
# TABLE OF CONTENTS

**Lesson #1: Understanding Accessibility** ................................................................. 5
Understanding Accessibility .................................................................................. 5
What Does “Accessibility” Mean? .......................................................................... 5
Where Can I Learn More about Different Types of Disabilities? ...................... 5
Referencing Individuals with Disabilities ............................................................ 6

**Lesson #2: Word Styles** ......................................................................................... 7
Working with Styles ............................................................................................... 7
Creating and Applying Styles .............................................................................. 7
Modifying an Existing Style ................................................................................ 9
Creating a Table of Contents from Styles .......................................................... 10

**Lesson #3: Formatting Text** ............................................................................. 12
Best Practices for Formatting text ........................................................................ 12
Working with Basic Font Formatting ................................................................... 12
Working with All Caps, Drop Caps, Word Art, and Headers ............................ 13
Creating Bulleted and Numbers Lists ................................................................. 15
Creating a Bulleted or Numbered List .............................................................. 15
Creating a Contextual Link .................................................................................. 16

**Lesson #4: Working with Visual Elements** ...................................................... 19
Working with Visual Elements .......................................................................... 19
Working with Images, Shapes, and Text Boxes .................................................. 19
Working with Charts and Graphs ...................................................................... 20

**Lesson #5: Working with Tables** ................................................................. 22
Working with Tables .......................................................................................... 22

**Lesson #6: Getting Started in PowerPoint** .................................................... 25
Utilizing PowerPoint for Presentations .............................................................. 25
Importing an Outline from Word into PowerPoint .......................................... 25
Adding a Presentation Transcript to the Slide Notes Pane ............................. 26
Accessibility Best Practices for Slide Design ...................................................... 27

**Lesson #7: Working with Slide Content** ....................................................... 28
Accessibility Best Practices for Slide Content .................................................... 28
Adding Content to Placeholders ....................................................................... 28
Adding Alternative Text to Images .................................................................... 28
Inserting Data Tables ......................................................................................... 30
Utilizing the Selection and Visibility Pane to Order Content .......................... 31

**Lesson #8: Working with Slide Masters** ...................................................... 33
PowerPoint Slide Master Tool ........................................................................... 33
Lesson #9: Office Accessibility Checker ................................................................. 36
Office Accessibility checker .............................................................................. 36
Running the Word Accessibility Checker ........................................................ 36
Running the PowerPoint Accessibility Checker ............................................... 36

Appendix A: Accessibility Resources ............................................................... 38

Technology Training Resources ....................................................................... 39
Through ITS Training Services ................................................................. Error! Bookmark not defined.
Additional Technology Resources ............................................................ Error! Bookmark not defined.
Lesson #1: Understanding Accessibility

OBJECTIVES
Participants will be able to

• Define what it means to optimize for accessibility
• Access resources related to different disabilities
• Define different types of disabilities
• Define appropriate language when referring to disabilities

UNDERSTANDING ACCESSIBILITY

What Does “Accessibility” Mean?

Accessibility can be described as making your product, establishment, service, or device available to as many people as possible. Sometimes the term universal design is used because improving access for audiences with disabilities often benefits all users. Examples include cut ramps on sidewalks or using heading styles to generate a table of contents. It often focuses on people with disabilities and their ability to access these items or environments.

It’s important to understand when creating documents, presentations, spreadsheets, websites, etc. that you can never have an item that is considered perfectly accessible. However, you can and should improve the accessibility of your files and websites using the techniques that will be covered throughout this training. This concept is often referred to as “optimizing for accessibility.”

Understanding the challenges that a person with a disability faces is an important part of the process. For a student’s perspectives on web accessibility and screen readers, you can check out the Keeping Web Accessibility in Mind video at http://youtu.be/yx7hdQqf8IE or watch a sign language video with no sound at http://youtu.be/QmKnQjBf8wM.

Where Can I Learn More about Different Types of Disabilities?

It’s a misconception that having a disability means that an individual cannot see or hear. An individual could have a visual disability, but still maintain some sight. An individual could have a hearing disability and still maintain some ability to hear. There are also other types of disabilities that a person may have that could require them to obtain a document or presentation that is “optimized for accessibility.” More information related to the following types of disabilities can be found at the Web Accessibility in Mind (WebAIM) website at http://www.webaim.org/:

• Visual
• Auditory
• Motor
• Cognitive
• Seizure disorders
You may also want to visit the Penn State Accessibility Web site at http://accessibility.psu.edu/

**Referencing Individuals with Disabilities**

It is important to use appropriate language when referring to individuals with disabilities. The following terms are highly offensive and unacceptable to use when referring to a person with disabilities:

- Handicapped
- Special
- Deficient
- Special needs
- Retarded
- Crazy
- Wheelchair bound
- Hearing impaired or challenged

It is important to use people-first language, focusing on the individual and not on his or her disability. For example, rather than saying, “A disabled person,” you should say “A person with a disability.”
Lesson #2: Word Styles

OBJECTIVES
Participants will be able to
• Create and apply styles
• Modify existing styles
• Create a table of contents using styles

WORKING WITH STYLES

Creating and Applying Styles

In Word, you can utilize styles that allow you to quickly and easily apply consistent formatting throughout your document. A style is a set of formatting characteristics, such as font type, size, color, and paragraph alignment and spacing. When styles are applied to content within your document, you can modify the formatting characteristics of the style. If you do so, those style-formatting changes will be applied to all of the content within the document to which that style is applied.

In addition to applying consistent formatting, heading styles will feed into a table of contents and most importantly, will create a list of headings to be viewed within a screen reader, like JAWS. The structure created by the heading styles enables screen reader users to navigate through the document easily. Screen reader users will have the ability to view the list of headings in a tab order or alphabetically. They will also have the option of filtering the list of headings by the heading level. Should they find a heading for content that is relevant to them within the list, they can quickly move directly to that heading within the document.

Figure 1: A heading list dialog box generated by the JAWS screen reader software.
Microsoft Word offers pre-defined styles for your document’s title, headings, subheadings, and text that can be modified, if needed. Word heading styles should be created according to content hierarchy. The Heading 1 should be used for the title of the document, the Heading 2 style should be used for major headings, and the Heading 3 style should be used for subheadings.

Although the instructions in this manual are written for Microsoft Office for a Windows machine, you can access additional information on using Microsoft Office 2011 for Mac by visiting the Penn State Accessibility website at http://accessibility.psu.edu/.

You may download the example files referenced in this document at http://tinyURL.com/TSAccessibilityFiles.

**EXAMPLE**

The University’s Department of Training Services would like to make their annual report available online for the public to review. Because this Word document will be posted on a department site and made available to the public, it must be optimized for accessibility.

In this exercise, you will format the title of the annual report with size 16, Arial Black font with six-point paragraph spacing. Then, you will update the default Heading 1 style within the document with the formatting applied to the report’s title. You’ll repeat this process for additional styles to be used in the report.

**Open the Document and Set the Font and Line Spacing**

1. Locate the examples files you downloaded.
3. Select the text displayed on the title page.
4. Apply the Arial Black font to the text.
5. Change the font size to 16.
6. Apply **12 point spacing** after each paragraph.
   a. Click the Line and Paragraph Spacing button.

   ![Figure 2: Line and Paragraph Spacing Button](image)

   b. Click the Line Spacing Options menu choice.
   c. Type 0 in the Spacing: Before field.
   d. Type 12 in the Spacing: After field.
   e. Click OK.
Update the Heading Style

1. Select the Home tab.
2. Right-click on the Heading 1 style within the Styles group.
3. Select Update Heading 1 to Match Selection from the drop-down menu.

Set the Heading 2 Style

1. Select the Executive Summary title text on page one.
2. Apply the Arial Black font to the text.
3. Change the font size to 14.
4. Apply 6 point spacing after each paragraph.
5. Right-click on the Heading 2 style within the Styles group.
6. Select Update Heading 2 to Match Selection from the drop-down menu.

Apply the Heading 2 Style

1. Select the Training Session and Audience Summary title heading on page one.
2. Select the Heading 2 style within the Styles group.
3. Apply the Heading 2 style to the following headings:
   - Instructor-Led Training
   - Evaluations
   - Renovations
   - Recommendations
4. Save your document.

Modifying an Existing Style

You can modify an existing style within this version of Word in order to change the formatting attributes of all text in the document to which the style has been applied. This is a fast and efficient way to make formatting changes to text within your document. “Existing styles” are styles that you either created yourself previously or Word’s default styles.

EXAMPLE

In this exercise, you will modify the Normal style that is applied to the text in the body of the report. You will change the formatting characteristics of this style so that the body text is Arial, size 11, with smaller paragraph and line spacing.
1. Select the Home tab, if necessary.
2. Right-click on the Normal style within the Styles group.
3. Select Modify from the drop-down menu.
4. Type **Body** in the Name: field.
5. Select **Normal** from the Style for following paragraph drop-down menu.
6. Select **Arial** from the font drop-down menu.
7. Select **11** from the Font Size drop-down menu, if necessary.
8. Select the **Format** button.
9. Select **Paragraph** from the drop-down menu.
10. Type **0 pt** in the Before textbox below the Spacing heading.
11. Select **Single** from the Line spacing drop-down menu.
12. Click the **OK** button.
13. Click the **OK** button.

The Normal style has now been renamed to Body and updated with new formatting characteristics. Notice that the formatting of all text that had the Normal style applied to it has now changed to Arial, size 11 font. The formatting attributes of all of this text can be changed again at any point in the future by modifying the Body style.

**Creating a Table of Contents from Styles**

A **table of contents** is a list of the headings of a document that is organized in the order in which the headings appear. As mentioned previously, utilizing styles within Word enables you to create a structure for your document. Not only does the structure assist screen reader users in locating important parts of the document, but it also allows you to create the table of contents quickly. You can choose to insert a pre-formatted table of contents by choosing one from a gallery or you can choose to insert a custom table of contents.

It’s a best practice to use the table of contents tool that is provided within Word to create a table of contents. Utilizing this tool will maximize efficiency and ensure proper formatting for accessibility purposes. For example, a table of contents normally displays the heading name on the left side of the page and then a line of periods or “dots” that leads to the page number on the right-hand side of the page. When the table of contents tool is used within Word, these periods or “dots” are not read by a screen reader. If you manually create a table of contents by typing in the heading names, typing a line of periods, and then typing the page number, a screen reader will read every single period to the user. You will also find it difficult to align the page numbers on the right-hand side of the page using this method.

**EXAMPLE**

In this exercise, you will insert a custom table of contents into page two of the annual report.

1. Place your **blinking cursor** at the top of the blank page.
2. Select the **References** tab.
3. Click the **Table of Contents** button in the Table of Contents group.
4. Select **Custom Table of Contents** below the gallery.
The Table of Contents dialog box will allow you to modify the settings of the table of contents that you are about to create. Within this box, you can choose whether or not you’d like to show page numbers, right align the page numbers, as well as select the tab leader character for a printed document. The tab leader character is the character that is used to create the line connecting the heading to the page number. You can also choose whether or not hyperlinks should be displayed instead of page numbers for documents displayed on the web.

Under the General heading, you can choose which table of contents to use as your template, as well as choose how many levels are displayed. You can specify which styles should appear in the table of contents and at which level they should be displayed. In this example, because the report’s title is listed as a Heading 1 style, it will show up in the table of contents by default. If you do not want a specific style to show up in the table of contents, you can access the options area to change these settings.

5. Click the **Options** button.

6. Remove the 1 from the Heading 1 style TOC level text box.

7. Type a 1 in the Heading 2 style TOC level text box.

8. Type a 2 in the Heading 3 styles TOC level text box.

9. Type a 3 in the Heading 4 style TOC level text box.

10. Click the **OK** button.

11. Click the **OK** button.

*Note: The table of contents can be updated by right-clicking on the table of contents and selecting **Update Field**. You will then have the choice to update the entire table of contents, or just the page numbers.*

**PRACTICE EXERCISE 1**

Create, modify, and apply styles to text within the Annual Report in order to format the document in such a way that it is optimized for accessibility.

1. Create a **Heading 3** style from the Most Popular Training Topics heading with the following formatting: Arial Black font, font size 12, 6 point spacing after each paragraph

2. Apply the **Heading 3** style to the Areas for Improvement text under the Evaluations heading.

3. Modify the **Heading 1** style by changing the text to a dark blue font color.

4. Update the **table of contents**.
   a. Right click on the **table of contents**.
   b. Select **Update field**.
   c. Select **Update entire table**.
   d. Click **OK**.
Lesson #3: Formatting Text

OBJECTIVES
Participants will be able to

• Define accessibility best practices for formatting text
• Create a bulleted and numbered list formatted for accessibility
• Create a contextualized hyperlink

BEST PRACTICES FOR FORMATTING TEXT

Text formatting not only enhances the design and visual appeal of your document, but it also helps to convey meaning. For example, in the previous lesson we created hierarchical headings based on the size of the heading styles. You should consider the formatting best practices in the section below when working within Word.

Working with Basic Font Formatting

**Font type and size** used within a document is not important for the purpose of screen readers. A screen reader is able to successfully read text of any type, at any size. However, font type and size is important for users with low vision or with some reading disabilities. In the interest of making your document as accessible as possible to all users, you may want to consider using a Sans Serif of at least 11-point size, preferably 12. For additional suggestions of legible fonts, visit the [Penn State Accessibility Website fonts section](http://accessibility.psu.edu/fontslayout) at http://accessibility.psu.edu/fontslayout.

Since you will never be able to find a font and size that is preferred by all users, using styles when formatting the text of your document will enable users to easily change the font size or type to meet their needs by modifying the style.

**Font color** should only be used as a design element and not to convey meaning. It’s possible that users with a sight disability will not be able to differentiate between colors or have the ability to see them at all. If you rely on using different colors to convey meaning, a screen reader will not be able to pick up on this meaning.

Also, it’s important to ensure that you use contrasting text colors such as black ink on a white page. It is a best practice to avoid using red or green font or page colors as these colors often cannot be distinguished by individuals with a color blindness disability.

**Bold and Italic**s are font or character formatting options that should be limited in a document that has been optimized for accessibility. Some users may have difficulty reading italicized text. Also, overusing the bold formatting option to emphasize information in your document will have an adverse effect and make it seem as though no information takes priority.

Instead of using the bold option to emphasize text within a document, it is a best practice to use the **Strong** style. Using the Strong style instead of bold will enable users to modify the style in order to enlarge those important keywords within the document, if needed.
Working with All Caps, Drop Caps, Word Art, and Headers

There are additional best practices to keep in mind when working with formatting the text within your document. Some features within Word can make optimizing your document for accessibility difficult; however, it is possible to use these features with some extra work.

The All Caps feature will allow you to change the case of selected text to all capital letters. It is a best practice to avoid applying All Caps to more text than would be displayed in a heading. While displaying large amounts of text in all capital letters will not cause issues with a screen reader, it can cause readability issues for all users especially those with low vision or reading disabilities.

A Drop Cap is large dropped initial capital letter often created for the first letter in a paragraph.

![Drop Cap Image]

Figure 3: Example of a Drop Cap that was saved as an image and inserted into Word.

The use of the Drop Cap is for visual, design purposes and does not have anything to do with conveying meaning. Because a Drop Cap is placed within a textbox that is separated from the rest of the text, a screen reader will not be able to read it. While it is not recommended to use a Drop Cap, if you would like to include one in your document, then you must save your Drop Cap as an image, insert that Drop Cap into the document in line with the existing text, and add Alternative text. Microsoft Word does not have a Save as Picture command available for text, so you will be required to create a Drop Cap in Microsoft Publisher or PowerPoint and save it as a picture there, or use screen-capture software.

WordArt is decorative text that can be added to a document. WordArt can be formatted to change its shape, color, font type, etc. Because WordArt is a decorative element, it is not necessary to a document and should be avoided. However, much like the Drop Cap feature, if you would like to include WordArt in your document, you must save the WordArt as an image, insert it into the document, and provide Alternative text. Just like Drop Caps, Word does not have a Save as Picture command available, so you will be required to create a WordArt element in Publisher or PowerPoint and save it as a picture there. Microsoft Office 2011 for Mac users also have the option of applying Text Effects to text in order to reformat text without placing it into a separate textbox.

![WordArt Image]

Figure 4: WordArt text that was saved as an image and inserted into Word.

Headers and Footers are spaces within the top and bottom of each page of your document that can contain static text or fields such as page numbers. Because adaptive technologies such as screen readers do not read headers and footers automatically, it is important that you do not
include critical information in this area alone. For example, screen reader users will not know the title of your document if it is only stored in the header, unless they intentionally access the header area, which is not a normal workflow process.
CREATING BULLETED AND NUMBERS LISTS

Bulleted and numbered lists are used to organize and draw attention to lists of two or more items within Word. When it comes to document accessibility, it is important to handle the creation of these lists properly so that screen readers can accurately convey the information to their users.

Creating a Bulleted or Numbered List

When creating a bulleted or numbered list, it’s important to ensure that you use the Word formatting commands within the Ribbon instead of inserting your own symbol to the left of the list text. Also, it’s important to adjust spacing between list items using the paragraph spacing tool instead of hitting the enter key. Adaptive technologies such as screen readers will read the list below that has been adjusted with paragraph spacing as “List start, bullet football, bullet basketball, bullet baseball, list end.”

- Football
- Basketball
- Baseball

The following list where spacing between the bullets has been adjusted by pressing Enter on the keyboard will be read as “List start, bullet football, list end, list start, bullet basketball, list end, list start, bullet baseball, list end.”

- Football
- Basketball
- Baseball

Not only is this confusing, but it will also appear to screen reader users that the items of the list do not relate to each other. Additional accessibility best practices for using bulleted and numbers lists in Word are as follows:

- Keep as many instructions as possible in the same list
- Avoid allowing lists to break across pages
- Avoid adding paragraph text in the middle of a list

When creating numbered lists, it’s important to use a different number scheme at each level of the list - which is the default setting of Microsoft Word. If you continually use the same numbering scheme for each level, your list will read as “1. Fall Sports, 1. Football, 2. Golf, 2. Spring Sports 1. Baseball” instead of the proper list below.

1. Fall Sports
   a. Football
   b. Golf
2. Spring Sports
   a. Baseball
EXAMPLE

Lists help concisely organize information in a visual manner. In this example, you will create a bulleted list and numbered list in order to organize information within the Annual Report. You will add some white space between each line of the list.

1. Select paragraphs 2 through 5 under the Training Session and Audience Summary heading on page one.
2. Select the Home tab.
3. Click the Bullets button in the Paragraph group.
4. Change the spacing to 9 points after each paragraph.
   a. Select the Line and Paragraph Spacing icon.
   b. Select the Line Spacing Options menu choice.
   c. Type 9 in the Spacing: After field.
   d. Uncheck the Don't add space… checkbox if it is checked.
   e. Click OK.
5. Select paragraphs 2 through 5 under the Most Popular Training Topics heading on page one.
6. Click the Numbering button in the Paragraph group.
7. Change the spacing to 9 points after each paragraph, if necessary.
8. Save your revised document at this time!

CREATING A CONTEXTUAL LINK

Utilizing contextual hyperlink text within Word is one the most important ways you can optimize your document for accessibility. A hyperlink is clickable text within a document or website that will send a user to another location within the document, to a website, or to open another file.

In Word, a hyperlink is automatically created when a user types a website URL within the document and then presses Enter or Spacebar on the keyboard. A hyperlink for The Pennsylvania State University website would be displayed as [http://www.psu.edu](http://www.psu.edu).

Most screen reader software applications will allow users to open a dialog box containing all of the links within the document. This dialog box allows users to navigate to a particular link easily. If the links are not created with contextual link text, then the list of links could be confusing. For example, if every link was created with the text Click Here, then the dialog box would be displayed as follows:
Figure 5: Screenshot of JAWS link dialog box containing 27 click here links.

Users will not know where they will be directed if they choose one of these links from the list. In addition, this type of vague, non-descriptive link text, users may also be confused or annoyed by hyperlinks that display the full website URL. Requiring the screen reader to read a lengthy URL that has little meaning to the user is not efficient or effective. It’s also a best practice to avoid using the same link text repeatedly throughout your document. If you do use the link text repeatedly, it will show up many times in the Links dialog box.

The goal with contextual link text is to concisely describe the destination of the hyperlink to a user so that they understand where they will be directed when they select it, even out of context. For example, the proper way to display a link to Penn State’s website for a document that could be printed or distributed electronically would be The Pennsylvania State University website at http://www.psu.edu.

**EXAMPLE**

In this example, you will create a contextual link that when clicked, will open a web page (if the computer’s settings allow it).

1. Select the **Training Department** text at the end of the document.
2. Select the **Insert** tab.
3. Click **Hyperlink** in the Links group.
4. Type http://ittraining.psu.edu in the Address: field.
5. Click the **OK** button.

The contextual link needed to open the Training Services Web site will be displayed. With this link, it will be clear to screen reader users that activating the link will enable them to open the Training Services Web site.
PRACTICE EXERCISE 2

Apply accessibility best practices in order to create, modify, and apply strong and list styles as well as create a contextual hyperlink within the annual report.

1. Modify the Strong style to include the Arial font with a size of 11 points. Apply this strong style to several numbers within the report to add emphasis.

2. Select the bulleted list and create a new style named Bulleted List based on the selected text. Then, modify the style so that the spacing after a paragraph is 6 points.
   a. Click the More button (lower right in the Styles panel).
   b. Click the Create a Style link.
   c. Type the name (Bulleted List).
   d. Click the Modify button.
   e. Click the Format button.
   f. Select the Paragraph menu choice.
   g. Change the After spacing to 6 points.
   h. Click the OK button.
   i. Click the OK button.

3. Apply the Bulleted List style to the two “University Query Tool…” paragraphs below the Instructor-Led Training heading, as well as to the text below the first paragraph under the Areas for Improvement heading.

4. Under the Renovations heading, type “Renovations were completed by John Smith Construction Company.” as the last line in the first paragraph. Insert a contextual link so that readers can access the company’s website, http://www.johnsmithconstruction.com.

   Example: Renovations were completed by John Smith Construction Company (see http://www.johnsmithconstructions.com).

PRACTICE EXERCISE 3

If you type a hyperlink, MS Word may automatically create a hyperlink for it. You may need to remove a hyperlink from a URL to follow the recommendations listed above. If the http://www.johnsmithconstructions.com from the above Practice Exercise is hyperlinked, you can select it and follow steps 2-4. Otherwise, do all of the following steps.

1. Select any point in the document and type http://www.psu.edu, then press Enter.
2. Click Hyperlinks in the Links group.
3. Click Remove Link.
4. Click OK.

You can delete the entire URL after this exercise.
Lesson #4: Working with Visual Elements

OBJECTIVES
Participants will be able to

• Understand accessibility best practices for images, charts, shapes, and text boxes
• Create Alternative text and captions

WORKING WITH VISUAL ELEMENTS

Word documents can contain several types of visual elements that can be used for design purposes or to convey meaning or information. These visual elements include images, charts, shapes, and text boxes. There are important accessibility best practices to keep in mind when working with visual elements in Word.

Working with Images, Shapes, and Text Boxes

There are several ways in which you can optimize the images within your document for accessibility. When an image is inserted, the text wrapping should be set to In Line with Text so that the object is not “floating” within the document and that no extra lines are present. These extra lines will be recognized by the screen reader and articulated to the user.

Floating objects will make it challenging for a screen reader to navigate the document. Examples of floating objects in Word include text boxes and shapes. Text boxes and shapes are not accessible; therefore, if you’d like to include them in your document, you must create them in some other software such as Microsoft Publisher or PowerPoint, save them as pictures, and then insert them into your document much like a Drop Cap or WordArt graphic. Then, you must add Alternative text and a caption to them. Also, you can choose to insert a border around text in a document to achieve the look of a textbox without worrying about creating a floating object.

Alternative text (ALT text) is text associated with an object, most often an image, which serves as a literal description of the image content that can be conveyed to a screen reader user. ALT text is not viewable in a printed or online document. ALT text should be concise and meaningful. You must add ALT text to all images within your document as an important step in optimizing for accessibility. It’s important to note that when you copy and paste an image from one location to another, or from one software application to another, the ALT text will be copied as well. For examples of proper ALT text, visit the Penn State Accessibility Image ALT Tag Tips webpage at http://accessibility.psu.edu/images.

Captions explain the content and context of an image within your document. Unlike ALT text, captions are displayed below an image and are viewable in a printed or online document. Therefore, important information such as copyright or technical information should be included as a caption so that all users will be able to see it. Captions should be added whenever possible as they are beneficial to all users in understanding the image content.
EXAMPLE

In this exercise, you will change the text wrapping of the renovation image on page 5 of the annual report example, as well as add Alternative text and a caption to the image.

Make the Image an Inline Image

1. Select the first image under the Renovations heading.
2. Select the Format tab.
3. Click the Wrap Text button.
4. Select In Line with Text from the Wrap Text drop-down menu.

Set the ALT Text

1. Right-click the image.
2. Select Format Picture from the drop-down menu.
3. Click on the Layout & Properties button in the Format Picture pane.

   ![Layout & Properties button.](image)

4. Select ALT TEXT.
5. Type Computer training classroom with no participants. in the Description field.
6. Click the X to close the Format Picture pane.

Create the Caption

1. Select the image.
2. Select the References tab.
3. Click the Insert Caption button in the Captions group.
4. Type Figure 1: The newly renovated Training Department computer classroom in the Caption textbox.
5. Click the OK button.

Working with Charts and Graphs

In addition to including Alternative text and captions for images, you must also add Alternative text and captions to charts and graphs in order to optimize your document for accessibility. The process for assigning ALT text and a caption to a chart or graph is similar to the process for an image. It is also a best practice to include normal text under the graph within a paragraph or a data table describing the data contained in the chart or graph.
EXAMPLE

In this exercise, you will change the text wrapping of the first chart, as well as add Alternative text and a caption.

Make the Chart an Inline Image
1. Select the chart under the Most Popular Training Topics heading.
2. Click on the Layout Options buttons next to the selected chart.
3. Select the In Line with Text icon from the menu.

Set the ALT Text
1. Right-click the chart near an edge, away from any text or graphics.
2. Select Format Chart Area from the drop-down menu.
3. Click on the Layout & Properties icon in the Format Chart Area pane.
4. Type Pie chart displaying the five most popular courses in the Description field.
5. Click the X button to close the Format Chart Area pane.

Create the Caption
1. Select the References tab.
2. Click the Insert Caption button in the Captions group.
3. Type Figure 1: The most popular training sessions of the Summer 2012 semester. in the Caption textbox.
4. Click the OK button.

PRACTICE EXERCISE 3

Apply Alternative text and captions to the remaining image and chart within the annual report.
1. Apply ALT text and a caption to the graph under the Evaluations heading.
2. Apply ALT text and a caption to the second image under the Renovations heading.
Lesson #5: Working with Tables

OBJECTIVES
Participants will be able to
- Understand accessibility best practices for tables
- Apply accessibility best practices for tables
- Create Alternative text and captions for tables

WORKING WITH TABLES
Improving the accessibility of tables within Word can be a big challenge. Adaptive technologies such as screen readers have very specific ways in which they convey table content to their users. It is a best practice to avoid using tables whenever possible within Word. If you must use a table within Word, there are a few best practices related to proper table structure to keep in mind, including:
- Always use tables for data only and not for design purposes
- Never create a table using the Draw Table tool
- Do not merge or split table cells
- Avoid empty cells by using a dash to fill the cell
- Do not allow table rows to break across multiple pages
- Never create extra space within a cell by adding hard returns or spaces (as the blank spaces will be read aloud to the user by the screen reader)
- Always include ALT text and captions for your table
- Never nest a table within a table

Properly structuring your table is critical to improving its accessibility for your users. It’s important to ensure that the relationships between the data in the table’s cells are clear to all users. First, you must consider what information should be used as a label to the columns of the table in a header row. Once you’ve created this row, changing the setting that will repeat the row as a header at the top of each page will identify this row as a header row to the screen reader, as well as repeat the row across multiple pages, if necessary. Finally, you will label the additional rows as well.

Note: See the Penn State Accessibility Web site at http://accessibility.psu.edu/tables for more information on tables.

EXAMPLE
In this exercise, you will insert a data table comparing the number of training sessions conducted by session type between 2011 and 2012. Using the best practices mentioned in the bulleted list above, you will format the table appropriately and add ALT text and captions.
Prepare a Table
1. Place your *insertion point* at the end of the Training Session and Audience Summary section.
2. Select the Insert tab.
3. Click the Table button.
4. Select Insert Table from the drop-down menu.
5. Insert a table with three columns and five rows.
6. Click OK.
7. Type Session Type, Number of Sessions 2011, and Number of Sessions 2012 in the three cells of the first row.
8. Type Scheduled, 9, and 17 in the three cells of the second row.
9. Type Training on Demand at UP, 24, and 39 in the three cells of the third row.
10. Type Training on Demand at Campuses, 14, and 16 in the three cells of the fourth row.
11. Type Vendor, 4, and 3 in the three cells of the fourth row.

Set the Header Row
1. Select the first row of the table.
2. Right-click on the table.
3. Select Table Properties from the drop-down menu.
4. Select the Row tab.
5. Select the Repeat as header row at the top of each page checkbox.
6. Click the OK button.

Set the Table Page Breaking Properties
1. Select the entire table.
   a. Click the table, then click the plus sign to the upper left of the table.
2. Right-click on the table.
3. Select Table Properties from the drop-down menu.
4. Select the Allow row to break across pages checkbox.
Set the ALT Text

1. Select the ALT text tab.
2. Type Data table comparing attendance by session type for 2011 and 2012 in the Description area.
3. Click the OK button.

Set the Caption

1. Select the References tab.
2. Click the Insert Caption button in the Captions group.
3. Select Table from the Label: drop-down menu.
4. Type Table 1: Number of training sessions attendees by session type with comparison by year in the Caption textbox.
5. Click the OK button.

Adjust the White Space Between Rows

1. Select the table, if necessary.
2. Select the Layout tab.
3. Change the Table Row Height to .35 inches in the Cell Size group.

Figure 7: Table Row Height button.
4. Change the formatting of the table and alignment of the text, if desired.

PRACTICE EXERCISE 4

Utilizing accessibility best practices for creating tables within Word, create a second table within the annual report.

1. Insert a table with three columns and four rows below the table created in the previous exercise.
2. Type Attendee Distinction, Attendees 2011, Attendees 2012 in the three cells of the first row.
3. Type Staff, 800, and 840 in the three cells of the second row.
4. Type Faculty, 200, 135 in the three cells of the third row.
5. Type Student, 170, 275 in the three cells of the fourth row.
6. Do not allow for rows to break across the page.
7. Define the first row as a header row.
8. Apply ALT text and a caption to the new table.

9. Make additional changes to the formatting and text alignment of the table as necessary.

10. Update the table of contents.

Lesson #6: Getting Started in PowerPoint

OBJECTIVES
Participants will be able to
- Describe how PowerPoint will be used for their presentation
- Import a presentation outline from Word into PowerPoint
- Utilize slides notes for a presentation transcript
- Understand slide design best practices for accessibility

UTILIZING POWERPOINT FOR PRESENTATIONS
PowerPoint is a commonly used software application for presentations. When a PowerPoint presentation is displayed in Slideshow view during a class, conference, event, meeting, etc. the majority of the content on the slides will not be accessible. For example, an audience member with a sight impairment may not be able to see your presentation at all. An audience member with a hearing impairment may not be able to hear any audio contained in the presentation.

However, because a PowerPoint presentation’s purpose is to complement what the speaker is saying and not to contain isolated usable information, audience members should be able to participate effectively. However, as a presenter you must be prepared to provide a presentation that has been optimized for accessibility to an audience member with a disability. One of the best ways you can optimize your presentation for accessibility is to ensure that your presentation is created in a hierarchical outline format. The easiest way to accomplish this task is to first create an outline of your presentation in Microsoft Word and then import that outline into PowerPoint.

Importing an Outline from Word into PowerPoint
Ensuring that your presentation is created in a hierarchical outline format is a big step toward optimizing your presentation for accessibility. Adaptive technologies such as screen readers will be able to convey information in this format to users much more easily.

Within the Microsoft Word outline, content that should be displayed as the slide title should have the Heading 1 style applied to it. Content that should be displayed as part of a bulleted list should have the Heading 2 style applied to it. When this information is imported, it will be translated to slide content. While this content will be simple and plain when it is imported into PowerPoint, it is a good starting point for a presentation optimized for accessibility.
It is important to keep in mind that some versions of Microsoft PowerPoint will only import a file in Rich Text Format or an .rtf file. Microsoft Office 2011 for Mac users must important their content from an .rtf file in order to complete the outline import.

**EXAMPLE**

In this example, you will import an outline from Word based on the Training Department’s annual report. This outline will be the basis for presentation delivered to senior leaders regarding the Training Department’s performance and accomplishments for the summer 2012 semester.

1. Open Microsoft PowerPoint.
2. Open a blank presentation.
3. Select the Home tab.
4. Click the arrow below the New Slide button.
5. Select Slides from Outline from the drop-down menu.
6. Locate the OutlineforPowerPoint.rtf file from your local computer.
7. Select the file.
8. Click the Insert button.
9. Select Slide 1 from the Slides pane.
10. Type Training Department in the Click to add title placeholder.
11. Type Annual Report in the Click to add subtitle placeholder.

The outline was imported into three news slides within the presentation. You may have noticed that you were required to manually type the title and subtitle of the presentation on first slide as the presentation title information will not be imported from a Word document.

It’s also important to keep in mind that in order to optimize your presentation for accessibility, you must use the content placeholders that PowerPoint provides for you. Just like in Word, inserting text boxes into the presentation will create “floating objects,” which are not accessible.

**Adding a Presentation Transcript to the Slide Notes Pane**

The PowerPoint Slides Notes pane will allow speakers to add a transcript of their presentation, which can be accessed by their users. Since slide content may not make sense out of the context of a presentation, adding this additional information in the slides notes pane is critical.

1. Select Slide 1 in the Slides pane.
2. Select Notes from the status bar at the bottom of the screen (If Click to add notes is not visible at the bottom of the screen).
3. Place your insertion point within the Notes pane.
4. Type This presentation is a summary of the Training Department’s performance and achievements for the Summer 2012 semester.
5. Select **Slide 2** in the Slides pane.

6. Click within the **Notes** pane at the bottom of the screen.

7. Type **In Summer 2012, we saw an overall decrease in the number of sessions and participants; however, our free offerings continue to grow due in part to the number of online sessions being offered. All of the statistics provided today were pulled from our new registration system.**

**Accessibility Best Practices for Slide Design**

When optimizing your presentation for accessibility, it’s a best practice to keep things simple in terms of your slide design. PowerPoint comes with a gallery of pre-defined slide designs; however, they may not be accessible to all of your users.

Keep the following best practices in mind when working with your slide design:

- Use contrasting colors (e.g. white background with black text)
- Avoid textured backgrounds
- Avoid red or green backgrounds and font colors
- Limit the amount of text on your slides
- Do not use color as the only way to convey meaning for your content
- Avoid automatic slide transitions
- Avoid complex slide animations
- Ensure the font size is sufficient for your in-person audience
- Provide a transcript for your presentation in the Note section of each slide
- Use legible fonts
Lesson #7: Working with Slide Content

OBJECTIVES
Participants will be able to
• Understand slide content accessibility best practices
• Utilize the Selection and Visibility pane to reorder content

ACCESSIBILITY BEST PRACTICES FOR SLIDE CONTENT
It’s important to note that some of the accessibility best practices for slide content are similar to the accessibility best practices reviewed for Word and some are specific to PowerPoint. These best practices include the following:
• Add Alternative text to images
• Use contextual link text
• Adjust spacing between bulleted and numbered lists using paragraph spacing tools
• Avoid inaccessible text boxes, shapes, and SmartArt graphics
• Place all content into content placeholders
• Do not overlap objects and placeholders
• Close caption all video content
• Make a transcript available for audio files
• Turn off the bulleted list feature when there is a single piece of content on the slide
• Ensure the source files for embedded Excel charts and Word documents are stored with the presentation folder

Adding Content to Placeholders
Images, charts, graphics, and text should all be inserted into slides through the use of content placeholders in order to avoid floating objects. Where these content placeholders are positioned on the slide is determined by the slide’s layout. You can choose the slide layout when the slide is inserted or change an existing slide’s layout. Just like in Word, adjustments made to the paragraph spacing and text alignment within a content placeholder should be completed using the paragraph spacing and alignment tools and not by adding additional hard returns using the Enter key on the keyboard. It’s also important to keep in mind that each slide should have a unique title, even if that means numbering the slides to differentiate slides with the same title – for example, Brick Techniques 1, Brick Techniques 2, etc.

Adding Alternative Text to Images
As mentioned in the best practices list above, all meaningful images within PowerPoint must contain Alternative text. Because PowerPoint is often used to visually enhance a presentation, slides may contain images that are purely for decoration. You should not provide Alternative text for the decorative elements to ensure the screen reader will ignore them.
EXAMPLE

In this exercise, you will insert a new slide into your presentation to discuss the renovations for the Training Department’s office suite. You will utilize content placeholders to insert the title and an image of the renovation into the slide.

**Insert a New Slide**

1. Select **Slide 4** in the Slides pane.
2. Select the **Home** tab.
3. Click the **arrow** below the New Slide button in the Slides group.
4. Select the **Two Content** slide layout from the gallery.

**Insert the Title and an Image onto the Slide**

1. Type **Office Renovations** in the Click to add title placeholder.
2. Click the **Picture** icon within the left-side placeholder.
3. Locate the **RenovationImage.jpeg file** within your local computer.
4. Select the **file**.
5. Click the **Insert** button.

**Add Text to the Slide**

1. Place your **insertion point** in the Click to add text right-side placeholder.
2. Type the following list in the placeholder:
   - Cosmetic renovation with new paint and carpeting
   - Six-week period and completed on time
   - Work by John Smith Contracting Company

**Format the Slide Text and Image**

1. Select the text **content placeholder**.
2. Select the **Home** tab.
3. Click the **Align Text** button in the Paragraph group.
4. Select **Middle** from the drop-down menu.
5. Right-click the **image**.
6. Select **Format Picture** from the drop-down menu.
7. Click on the **Size & Properties** icon in the Format Picture pane.
8. Select the **ALT text** tab.
9. Type Computer training classroom with no participants. in the Description textbox.

10. Click the X to close the Format Picture pane.

Inserting Data Tables

Much like in Microsoft Word, improving the accessibility of tables within PowerPoint can be a big challenge. It is a best practice to avoid using tables whenever possible within PowerPoint.

If you must use a table, there are a few best practices to first keep in mind including:

- Always use tables for data only and not for design purposes
- Always insert the table using the icon in the content placeholder
- Copying a table from MS Word or MS Excel is problematic and should be avoided
- Do not merge or split table cells
- Avoid empty cells by using a dash to fill the cell
- Never create extra space within a cell by adding hard returns or spaces (as the blank spaces will be read aloud to the user by the screen reader)
- Always include ALT text and captions for your table
- Use proper table structure to convey the data content

It’s important to ensure that the relationships between the data within the table’s cells are clear to all users. First, you must consider what information should be labels for the columns of the table in a header row. Then, consider how you will label the rows as well.

EXAMPLE

In this exercise, you will insert a new slide containing a data table in our presentation.

Create a New Slide and Add a Title

1. Select Slide 3 in the Slide pane.
2. Insert a new Title and Content slide.
3. Type Session Type Comparison 2011 vs. 2012 in the Title placeholder.

Insert a Table

1. Click the Insert Table button.
2. Insert a table with three columns and five rows.
3. Type Session Type, Number of Sessions 2011, and Number of Sessions 2012 in the three cells of the first row.
4. Type Scheduled, 9, and 17 in the three cells of the second row.
5. Type Training on Demand at UP, 24, and 39 in the three cells of the third row.
6. Type **Training on Demand at Campuses, 14, and 16** in the three cells of the fourth row.

7. Type **Vendor, 4, and 3** in the three cells of the fourth row.

**Format the Table**

1. Right-click on the **table** to select it.

2. Select **Format Shape** from the drop-down menu.

3. Click the **Size & Properties** icon in the Format Shape pane.

4. Select **ALT Text**.

5. Type **Data table comparing attendance by session type for 2011 and 2012**.

6. Click the **X** to close the Format Shape pane.

See the Penn State’s Accessibility Web Site section on tables at http://accessibility.psu.edu/tables/ for more information.

**Utilizing the Selection and Visibility Pane to Order Content**

In PowerPoint, the order in which your slide’s content is “tabbed” to is the order in which the content is read by a screen reader. It’s important to ensure that your tab order is a logical one when working with the content on your slides. You can view the tab order of your content by accessing the Selection and Visibility task pane.

Within the Selection and Visibility task pane, the order in which your content will be read by a screen reader is displayed from **bottom to top** which can be a bit confusing as you may expect the order to be presented from top to bottom. In this pane, you can reorder your content, if necessary, to ensure that it will be read in a logical order by adaptive technologies.

**EXAMPLE**

In this exercise, you will reorder the content on Slide 5 using the Selection and Visibility task pane, so that the bulleted list is read before the image’s alternative text.

1. Select **Slide 5** from the Slides pane.

2. Select the **Home** tab.

3. Click the **Arrange** button in the Drawing group.

4. Select **Selection Pane** from the drop-down menu.

5. Select the **Text Placeholder** within the Selection pane.

6. Click the **down arrow button** at the top of the Selection pane.

When working with a slide with more content, you would want to continue steps 1 through 6 in the list above until you have all of your content arranged in a logical reading order.
PRACTICE EXERCISE 5

Utilizing accessibility best practices for creating tables within PowerPoint, create a second table within the presentation.

1. Insert a **new Title and Content slide** after Slide 4.
2. Type **Attendee Distinction 2011 vs. 2012** in the Title placeholder.
3. Insert a table with **three columns and four rows**.
4. Type **Attendee Distinction, Attendees 2011, Attendees 2012** in the three cells of the first row.
5. Type **Staff, 800, and 840** in the three cells of the second row.
6. Type **Faculty, 200, 135** in the three cells of the third row.
7. Type **Student, 170, 275** in the three cells of the fourth row.
8. Add **Alternative text** to the new table.

PRACTICE EXERCISE 6

An additional image of the office renovation should be included in the presentation after the Office Renovations slide. Once that image is included, the presentation is complete.

1. Insert a **Picture with Caption slide** after the Office Renovations slide.
2. Insert the **RenovationImage2.jpeg** file into the slide.
3. Add a **caption** to the image using the top content placeholder below the image.
4. Add **Alternative text** to the image.
5. Review the **Selection and Visibility pane** for each slide and make any order adjustments, if necessary.
Lesson #8: Working with Slide Masters

OBJECTIVES
Participants will be able to
- Describe how to use slide masters for accessibility purposes
- Add content to slide masters

POWERPOINT SLIDE MASTER TOOL

A Slide Master stores information about the design, theme, and layout of slides within your presentation. This information includes things like background, color, font attributes, placeholder sizes and positions of your objects. Every presentation you create will have at least one slide master.

Slide masters play an important role in optimizing your presentation for accessibility. You should utilize the slide master to include any design elements for your presentation such as a logo for your department, college, or organization. These design elements are not critical to the presentation and will most likely show up on many, if not all, slides. There is no value in having an adaptive technology read Alternative text to describe these purely decorative and branding elements.

Also, slide masters allow you to create custom layouts for your slides. Any time that you would like to rearrange content placeholders to meet your needs, you must do so within the slide master area.

EXAMPLE

In this exercise, you will add the Training Department logo to the bottom left hand corner of the slide master. Also, we will create a new slide layout that displays a title and three content placeholders.

1. Select the View tab.
2. Click the Slide Master button in the Master Views group.
3. Click the arrow on the bottom of the Insert Layout button in the Edit Master group.
4. Click the Content choice from the pulldown menu.
5. Click the Insert Placeholder button in the Master Layout group.
6. Draw a content placeholder within the new slide master layout that vertically spans one-third of the slide.
7. Insert two additional content placeholders within the remaining empty space of the slide (Repeat steps 2-6 two times).
8. Right click the new slide design in the left window.
10. **Rename** the new layout to read Three Content.

11. Click the **Rename** button.

12. Select the **Insert** tab.

13. Click the **Pictures** button.

14. Locate the *TrainingDepartmentLogo.png* file on your computer.

15. Select the **file**.

16. Click the **Insert** button.

17. Move the **image** to the bottom right-hand corner of the slide.

18. Select the **Slide Master** tab.

19. Click the red **Close Master View** button.

20. Select the **Home** tab.

21. Click the **arrow** under the New Slide button in the Slides group.

22. Select the **Three Content**, Custom Layout option from the gallery.

Notice that a new slide with the custom layout has been inserted into the presentation. Also, notice that the Training Department logo is displayed in the bottom right-hand corner of every slide. This logo is displayed on every slide because it was placed on the Slide Master for the presentation. Every new slide inserted from this point forward will contain this logo, regardless of the layout that was chosen. Additionally, this slide has three “legitimate” content holders so you will not be tempted to manually add a (minimally accessible) text box if you need one – it’s already there.

![Click to edit Master title style](image)

Figure 8: Custom PowerPoint slide master containing a title placeholder and three content placeholders.
PRACTICE EXERCISE 7

The Training Department has decided to make changes to the slide master and custom layout that was previously created for the annual report presentation. Make the following changes to the presentation.

1. Move the **Training Department logo** to the middle of the bottom of the slide master.

2. Create a **custom slide layout with three content placeholders**. One content placeholder should take up a third of the slide vertically. The other two content placeholders should be stacked on top of each other horizontally in the remaining portion of the slide.
Lesson #9: Office Accessibility Checker

OBJECTIVES
Participants will be able to
• Run the Office Accessibility Checker
• Resolve accessibility issues detected in a document

OFFICE ACCESSIBILITY CHECKER
Much like the Word and PowerPoint spell checker detects possible spelling and grammar errors, the Word and PowerPoint Accessibility Checker will detect possible accessibility issues within your document or presentation. Running the Accessibility Checker is a critical process in optimizing your documents and presentations for accessibility and should be done when you have completed your project.

Running the Accessibility Checker on the Windows Version of Word
Complete the following steps to run the Word Accessibility Checker:
1. Open the Word document.
2. Select the File tab.
3. Select Info from the left-hand menu.
4. Click the Check for Issues button.
5. Select Check Accessibility from the drop-down menu.
6. Review the list of potential errors in the Accessibility Checker pane.
7. Resolve any outstanding accessibility issues listed in the results.

Running the Accessibility Checker on the Windows Version of PowerPoint
Complete the following steps to run the PowerPoint Accessibility Checker:
1. Open the PowerPoint presentation.
2. Select the File tab.
3. Select Info from the left-hand menu.
4. Click the Check for Issues button.
5. Select Check Accessibility from the drop-down menu.
6. Review the list of potential errors in the Accessibility Checker pane.
7. Resolve any outstanding accessibility issues listed in the results.

Running the Accessibility Checker on Recent Macintosh Versions of Word and
**PowerPoint**

Complete the following steps to run the PowerPoint Accessibility Checker:

1. Open the **PowerPoint** presentation.
2. Select the **Review** tab.
3. Click the **Check Accessibility** button.
4. Review the list of potential errors in the Accessibility Checker pane.
5. Resolve any outstanding accessibility issues listed in the results.

*Note: Unfortunately, the Microsoft Office 2011 for Macintosh version of Word and PowerPoint do not contain an accessibility checker.*
Appendix A: Accessibility Resources

- Penn State Accessibility Website (http://www.accessibility.psu.edu)
- Web AIM techniques for Accessibility in Word (http://www.webaim.org/techniques/word)
- Web AIM techniques for Accessibility in PowerPoint (http://www.webaim.org/techniques/powerpoint)
Technology Training Resources

Through IT Learning and Development

Find face-to-face and online training workshops at http://lrn.psu.edu/

Request Training On Demand (sessions upon request for groups of five or more) at http://itld.psu.edu

Explore thousands of free video tutorials that are available for self-paced learning at http://lynda.psu.edu/

Discover training news, fun tips, and session reminders via social media on @PennStateITLD (Twitter) http://www.facebook.com/PennStateITLD (Facebook)

Join one of our news lists to receive monthly email notification of all upcoming technology training opportunities, by sending a blank email to L-TRAINING-NEWS-SUBSCRIBE-REQUEST@LISTS.PSU.EDU (Training News List) L-FACULTY-TECHTRAINING-SUBSCRIBE-REQUEST@LISTS.PSU.EDU (Faculty Training List) L-CAMPUS-TECHTRAINING-SUBSCRIBE-REQUEST@LISTS.PSU.EDU (Campus Training List)

Additional Technology Resources

Contact the IT Service Desk with general technology-related questions by emailing ITServiceDesk@psu.edu or call 814-865-4357 (HELP)

Search for technology-related information in the IT Knowledge Base at http://kb.its.psu.edu/

Purchase discounted software or software licenses through Penn State at http://software.psu.edu/

Access free online books about popular technology topics through the Penn State Libraries at http://proquest.safaribooksonline.com/